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This document is intended to provide guidance and is not intended to supersede 

any guidance developed by the Texas Department of Public Safety or the Texas 
Division of Emergency Management.  
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Preface 

The Preparedness Section’s planning units—the Plans Management Unit, Continuity 
of Operations (COOP) Unit, the Local and Regional Plans Unit, and the State and 

Federal Plans Unit—produce many kinds of documents, such as plans, annexes, 
reports, proposals and presentations. These documents are developed for a wide 

range of internal and external audiences, including federal, state, tribal, local, 
nonprofit and private sector partners. Thus, our planners must make frequent 
editorial and stylistic decisions, often under tight time constraints.  

While the content of our documents varies greatly, the documents themselves must 

reflect a standard and consistent approach to communicating information. Apart 
from our ability to speak and write standard English, documentation standards, 
such as those presented here, are the foundation of professional, trustworthy 

communication.  

This document provides the writing, design and presentation standards that help 
planners maintain a consistent, uniform “voice” and format within each document 
and across all products. These standards are designed to foster a strong and 

consistent image for both internal and external audiences. In doing this, we help 
ensure that all our documents meet professional communication standards and 

inspire confidence and trust among the people we serve.  

The attributes we believe make our products professional, easy-to-use and 

trustworthy are as follows: 

 Accessibility  

 Accuracy 
 Clarity 

 Brevity 
 Consistency 

 
To supplement guidelines from the Texas Department of Public Safety, Texas 
Division of Emergency Management (TDEM) Community Relations, the 

Preparedness Plans Team developed these planning-specific standards and 
guidelines for writing, graphics, editorial style and publishing. Consult Webster’s 

New World College Dictionary, Fourth Edition, for preferred spelling, hyphenation 
and abbreviation. For general style follow The Associated Press Stylebook and 
Briefing on Media Law (AP Stylebook), and, where AP is silent, The Chicago Manual 

of Style, 16th Edition (University of Chicago Press 2010). For guidance on clarity and 
brevity, look to the Federal Plain Language Guidelines developed by the Plain 

Language Action and Information Network (PLAIN) under the Plain Writing Act of 
2010. For matters of accessibility and usability we look to guidelines presented by 
the U.S. Department of Health and Human Services on their website at 

www.hhs.gov/web/508. 
 

The development of this document was supported by the Regional Catastrophic 
Preparedness Grant Program. 

file://HQEMSS001/Public/Sections/Preparedness/PLANS-State%20&%20Federal/Unit%20Internal/Style/Current%20Draft/www.hhs.gov/web/508
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Using This Document 
Use this document as a reference tool to produce accurate, reliable 

plan documents. This section helps you quickly find what you need. 

This document is not designed to be read from cover to cover. Use this page as a 
navigation tool to quickly find the information you need. 

Find general background information, goals and assumptions here. 7 

Learn how to open, name and save a document file here. 8 

Review language style here. 18 

Learn how to visually format content beginning here. 36 

Turn here to find the Pre-Review Checklist. 56 

Find reference materials here. 60 

When you see a reference arrow (↗), look to the bottom of the page for a reference 

link to additional information from the state of Texas.  

If you do not see what you’re looking for right away, remember that you can search 
the document for a specific term by pressing Ctrl + F and typing the term in the 

search window. 

 

 

 

 

 

 

 

 

 

 

 

 

This document is one in a series of emergency management planning guides and 

tools developed by TDEM’s Preparedness Plans Team. All documents in the series 
combine to form The Planner’s Toolkit.  



March 31, 2015 Documentation Standards 7 

Overview and Purpose 
This document presents standards and guidelines you can use to 

create superior communication products. The following goal, 
objectives and underlying assumptions guide the development, 

maintenance and use of this document.  

Goal 
Significantly advance the Texas Division of Emergency Management (TDEM) 
Preparedness Section ability to produce accurate, clear, accessible and professional 

communication products that serve and support Texas’ emergency management 
community.  

Objectives 
 Serve as a single, authoritative, user-friendly source of information about style.  
 Help staff make consistent decisions about how to document information and 

communicate information to others.  
 Recommend standards for creating, sharing and managing documents. 

 Recommend useful, consistent standards for writing, editing and usage. 
 Recommend useful, consistent standards for design and visual presentation. 
 Recommend useful, consistent standards for developing accessible documents that 

respond to Section 508 guidelines. 
 Provide additional guidance to staff working with standard and modifiable wording 

in document templates. 
 Reiterate TDEM style. 

Audience 
 Preparedness planning unit planners, writers and editors.  
 Other interested TDEM planners, planning partners and other stakeholders. 

Planning Assumptions 
 TDEM plan documents are used by TDEM planners and TDEM planning partners, 

emergency responders, community stakeholders, office holders and members of the 

interested public. 
 TDEM plan documents are used during stressful situations when critical decisions 

must be made quickly. 
 Documents that are accurate, clear and accessible facilitate efficient and effective 

decision-making under pressure. 

 In accordance with National Incident Management System (NIMS) guidelines, 
consistent documentation supports effective emergency management by ensuring 

all stakeholders have access to identical versions of the same information, 
regardless of situation or location. 

 Style helps ensure consistency and conformity to recognized standards.  

 Style inaccuracies delegitimize text by distracting readers, causing them to doubt 
the accuracy and authority of the text. 

 Style evolves, but only as necessary, because even minor changes have far-
reaching implications. 
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Getting Started 
Standards for creating and sharing document files streamline 

document development, management and publication. This section 
explains our standards for creating, naming, saving, sharing and 

tracking changes to documents. 

Our document development tools are designed to help planners create professional 
and publishable documentation efficiently while producing a clear, user-friendly 

product. To do this, we have developed a menu of templates with pre-formatted 
styles. These tools help speed document development using a clean and clear 
document format. 

Open a New Document 
The Plans team creates most documents in Microsoft Word or Microsoft Excel. We 

have also developed MS Word document templates for specific uses. Using these 
templates helps standardize our communication and the presentation of our brand.  

Name and Save Your Document  
Use the following naming convention to name your document: 

YEAR_MO_DAY_Document_Name_your-initials 

2014_01_15_Firefighting_Annex _jk 

File names are less than 30 characters and clearly indicate their content. File names 
do not contain spaces or special characters other than the underscore. 

Save your document to the appropriate folder on the shared hard drive, according 

to its file structure. 

Control Document Versions  
Because our documents are developed with input from many sources, it is essential 

to ensure that there is only one “live” version of a document at any given time. 
When two or more people unknowingly work on a document at the same time, they 

create two live versions, which someone then must synthesize into one.  

Therefore, avoid working on documents saved onto your hard drive. When you 

work with the live version on the shared hard drive, it is unavailable to anyone else 
who tries to edit it. 

Personalize Your Versions  
Often two or more people work on a single document in rapid succession on the 
same day. When this happens each person adds his or her initials to the end of the 

file name of each successive version. 
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Here is how a document file name would change for a file that was developed by 
ak, sent to pt for review, and returned to ak to make corrections before saving the 

revised document to the shared hard drive: 

2014_07_23_Mass_Care_Annex_ak 

2014_07_23_Mass_Care_Annex_ak_pt 

2014_07_23_Mass_Care_Annex_ak_pt_ak 

The document owner changes the file name date if the document is modified at a 
later date: 

2014_07_26_Mass_Care_Annex_ak 

Note that when the date changes, the initials are reset by the document owner. 
Save previous document versions in a “Drafts” or “Archive” folder in the document’s 
folder on the shared hard drive. 

Track Changes for Internal Reviews 
When editing a document in MS Word, use “Track Changes” to capture a history of 

changes made. To use Track Changes, go to the MS Word ribbon and select the 
Review tab. Click “Track Changes” in the ribbon.  

Track-Changes Etiquette  
When you respond to a reviewer’s comments on a document, prepare a revised 

draft in which you “accept” and respond to the reviewer’s comments. When you 
return your revision to the reviewer, remove the reviewer’s original comments but 

track and show your revisions. An exception is made when the reviewer poses a 
question and expects an answer. All previous versions, with comments, are 
preserved in the document’s draft folder on the shared hard drive. 

Use AP Proofreading Marks 
When editing a printed copy of the document, use Associated Press (AP) style 

proofreading marks found in the back of the AP Stylebook (Associated Press 2012). 

A Word about Plagiarism and Copyright  
Always cite your sources. You may paraphrase, but doing so requires changing both 

words and sentence structure. Citations are still required when you paraphrase. For 
more information, refer to References below. 

All information in our documentation is original content that we created or, if not, 
used with the permission of the copyright holder. This is true for both text and 

images. Do not assume that content in U.S. government publications may be used 
verbatim without permission. When in doubt, check with your supervisor about 
anything that might be considered copyright infringement.  
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Getting Started Checklist 
Use this checklist to make sure you are creating, saving and sharing documents 
according to plans team guidelines. 

Complete Task 

 Know which document template to use for your purpose. 

 Name the document using the Plans team naming convention. 

 Save the document to the correct location on the shared hard 

drive. 

 Control document versions, making sure there is only one 

“live” version at any given time. 

 Work with documents on the shared hard drive, rather than on 

your hard drive, so that others do not inadvertently make 
changes to an earlier version. 

 Save previous versions of the document in a “Drafts” or 
“Archive” folder on the shared hard drive. 

 Personalize versions of the document. 

 Use the “Track Changes” feature in MS Word to make and 

track edits and comments among multiple reviewers. 

 Return clean versions of the document to reviewers. 

 Use Associated Press (AP) proofreading marks when editing a 
hard copy. 

 Cite all sources and check with your supervisor if in doubt 
about copyright infringement. 
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Developing Content 
Creating and revising content is the basic work of document 

development. This section offers guidance on crafting plans, annexes 

and other documentation. 

Many Plans team documents follow a prescribed format and involve extensive 

collaboration with dozens of contributors. Planners receive, revise and synthesize 
information into a coherent whole that documents vital aspects of the state’s 

emergency preparedness.  

Other documents are less structured and less collaborative, but they are not 

necessarily less demanding. Whatever the case, documentation is more effective 
when it is developed with following basic guidelines in mind: 

 Understand and speak to the audience. 
 Organize content effectively. 

 Express information clearly and concisely. 
 Use lists, tables and graphics effectively. 

 

Effective documents are also carefully edited and polished according to established 
standards for accuracy, consistency and quality. For more information, refer to the 

Language Style, Visual Style, and Accessible Style sections below.  

Know the Audience 
It is important to know the audience for any communication. Most people take this 

for granted in face-to-face conversation, but tend to forget it when they write. 
Before you start writing, use the following questions to understand the audience: 

 Who are they and why are they reading the document? 
 What information do they expect to find there and why do they want it? 

 How much do they know about the topic? 
 What are their biases and opinions about it?  

 How do they judge the accuracy and reliability of this information? 
 What standard do they use to judge the value of this information? 

 

You may not be able to answer some of these questions. Others may not be 
relevant. One or two, however, might lead you to an important insight, making 

your document more effective, because understanding your audience is as 
important as understanding your topic. 
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Use the Active Voice 
Use the active voice because it usually results in a clearer, more concrete 
statement. Write sentences that follow the form subject-verb-object. Compare the 
active and passive voice examples below: 

Active  Passive 

TDEM coordinates mass care operations. Mass care operations are coordinated by 

TDEM. 

The state’s Mass Care Coordinator 

assesses overall mass care needs. 

The state’s overall mass care needs are 

assessed by the state’s Mass Care 

Coordinator.  

The SOC uses several tools to gather and 

analyze data and reports. 

Several tools are used by the SOC to 

gather and analyze data and reports. 

 

The active voice statements are more direct. They describe action and are easier to 
understand. They are more quickly understood, which readers appreciate. 

Write in the Third Person 
Although this document is written using the second-person point of view, most plan 
documents are written using the third person point of view. The third-person point 
of view creates a more appropriately sober and neutral tone. Unfortunately, this 

point of view often leads to passive voice constructions. Avoid them whenever 
possible. 

Use the Present Tense 
Plan documents that either describe or compel action are written with this basic 
planning assumption: Our readers are either responding to an incident as it occurs, 
or they are reading on behalf of those who do. In either case, it is not helpful or 

necessarily accurate to describe future conditions. As an incident unfolds, so does a 
structured, well-coordinated response, moment by moment, in the present tense.  

Therefore, do not use the future tense will, which implies more knowledge and 
control of future events and conditions than we as planners possess.   

Similarly, state emergency management plan documents do not use the word 
should. Documents developed by the Local and Regional Plans unit, however, may 

use the word. The state plan documents and annexes are not prescriptive.  

Get Organized 
A strong structure is the basis of most effective writing, especially technical writing 
or writing that explains a process. If you are following a prescribed structure, such 
as that of an annex to the State of Texas Emergency Management Plan, decisions 

about how the content is organized and presented are required. 
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A Simple Approach 
Simple as it sounds, organizing your subject into a basic outline keeps you focused 
on your goal: an accurate, clear and concise presentation of the material.  

Try this method: 

1. Write down the main topic or main heading. 

2. List the subtopics or headings in any order they occur to you. 
3. Review the main heading: is it still accurate and complete? 

4. Review the subtopics:  
a. Are they the same level of importance? 
b. Do they all fit beneath the main topic?  

c. Are any missing? 
5. Order the subtopics based on what the intended audience needs to know first, 

second, third and so on, beginning with the basic facts. 
6. Build out the subtopics with sub-subtopics. 
7. Review the outline, testing its logic and organization. 

 
Now validate the outline’s organization. The outline may change significantly 

because of new information, something you did not foresee or because something 
does not look right. As annoying as this is, it is less frustrating than making the 
same changes to a document that has been drafted and reviewed.  

Focusing on the structure and organization of the content helps you stay focused on 

your communication goal. It provides a roadmap through the document’s 
information landscape. With such a roadmap, you are less likely to be delayed and 
distracted by the details of expression.   

Additional Organizational Ideas and Tips 
 Organize material in the order in which the audience expects to see it. 
 Put the most important information at the beginning. 

 Put general information first, followed by specialized information or exceptions. 
 If your content addresses a process, organize it chronologically. 

Keep It Simple  
As you draft the document, try to present information as concisely and clearly as 
possible. Doing so helps readers process and understand information, especially 

those readers who cannot or do not have time to read in depth.  

Often we trade accuracy for simplicity: We explain something clearly and quickly or 

we explain it accurately and completely. Plan documents, however, strive to be all 
of these: accurate, complete, clear and concise. Here are some tips: 

Start With the Main Idea  
Write the most important things you want to say about the topic first. Start with the 

main points before writing about conditions or exceptions. It may help to write 
everything out at once, knowing you can edit later. 

Shorten Long Sentences  
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After finishing the draft, you begin to prune. Keep sentences short and simple: 20 
words or less. Sentences need only express one idea or complete thought. Complex 

sentences can usually be improved by breaking them into two shorter sentences. 
Make sure the point is still clear. Do not use italics or other typographic devices to 

emphasize or clarify meaning. 

Write Short Paragraphs 
When you shorten sentences, you often clarify the information. Similarly, keep 
paragraphs short, between four and six sentences. This guides your readers 

through the content and keeps them on track. 

Use Descriptive Headings 
Help readers skim for information by writing short paragraphs and descriptive 
headings that clearly identify the content. The paragraph headings probably match 

topics and subtopics in the outline.  

Write for a Sixth Grader 
Use simple language. Documents are simple and clear enough to be read and acted 
on by non-specialists with limited vocabularies. Although not always accurate, MS 

Word allows you to check a document’s readability, or grade level.1 Our plan 
documents are written at a sixth grade reading level. 

Use a Thesaurus 
While drafting a document, keep the thesaurus in MS Word open to find shorter, 
simpler words. To find the thesaurus, go to the “Review” tab in the ribbon and 
select “Thesaurus.” 

Eliminate Clutter 
Eliminate empty, clunky language, such as the following official-sounding phrases:  

 as appropriate 

 at this point in time 
 in response to 

 of a similar nature 
 take into consideration 
 with your permission 

 with respect to 

Eliminate Redundancies  
Look for and remove redundancies, which often hide in tired or trite expressions, 
such as the following: 

 advance planning (or warning)  

 integral part 
 mutual cooperation 
 root cause 

 separate entities 

                                       
1 For more information, refer to the Microsoft Office website: http://office.microsoft.com/en-

us/word-help/test-your-document-s-readability-HP010354286.aspx 

http://office.microsoft.com/en-us/word-help/test-your-document-s-readability-HP010354286.aspx
http://office.microsoft.com/en-us/word-help/test-your-document-s-readability-HP010354286.aspx
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 serious danger 
 violent explosion 

 
The Federal Plain Language Guidelines2 provide useful advice and tips for 

eliminating clutter and developing clear and concise documents.  

Schedule Review Time 
Finally, schedule time in the project plan to review your work with fresh eyes. What 
sounded clear when it was first written may sound less clear when read later. 

Alternatively, ask another planner to read your document. Ideally, this person is 
someone who is unfamiliar with the document’s content and is therefore more likely 

to notice things others have missed.  

Be Graphic 
Many people process visual information faster than they do verbal information. This 

is one reason why emergency communication relies on color, shape and contrast to 
communicate information. Further, many people would rather look at information in 

a table, chart or simple diagram than several paragraphs of dense text.  

When creating content, it is usually best to develop an outline before developing 

graphics. If you are facing several pages of dense text, try thinking about the 
information differently. Begin with these questions: 

 How does the information look at first glance? 
 What form has it been given? 

 How is the information organized?  
 Are there headings? If so, how many levels are there? 
 Are there any visuals, such as vertical lists, examples, tables, diagrams or maps?  

 If not, are there opportunities to use them? 
 

It is important, of course, to understand the content before dividing it up visually 
and verbally. As a subject-matter expert, however, do not forget your first 
impression of the material. Recall what was initially confusing and attack any 

lingering ambiguities. A solid wall of opaque text involves more than adding a 
photo, a caption or a table to unlock its meaning.  

After examining the content, identify opportunities to replace words with a visual 
device, so that words and graphics combine for the most effective presentation. Use 

the following table as a guide. For more information on each element refer to 
Language Style and Visual Style and Formatting below. 

 

 

Device  When to Use 

                                       
2 For more information, refer to Federal Plain Language Guidelines at 

http://www.plainlanguage.gov/. 

http://www.plainlanguage.gov/
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Device  When to Use 

Bullet List 

 

Use bullets to highlight examples, items in a series, or 

exceptions. Bullets work best when used with single words or 

short phrases. 

Numbered List Use similarly to bullets, but reserve numbers for steps in a 

sequence. 

Examples 

 

Examples pause the flow of information, allowing readers to 

confirm their understanding. Examples can be set off from the 

text but are not ancillary. 

Tables 

 

Use tables to clarify relationships among categories of 

information when these relationships are difficult to infer from 

text alone. 

Charts and Graphs Charts and graphs quantify and compare information in 

dramatic and effective ways. Plans documents tend not to deal 

with comparative data, but these devices are used as needed.  

Maps 

 

Use as needed, but make sure the map appears in the 

document large enough to read. Miniature maps are not 

helpful.  

Diagrams Use MS Visio to draw diagrams of complex processes.   

Illustrations Use to show a detailed or expanded view of a thing or system 

or to isolate key information.  

Photographs Use to bring visual interest and life to content, but make sure 

they convey information and are not decorative. 
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Developing Content Checklist 
Use this checklist to help you develop your content. 

               Developing Content Checklist 

 
Understand the intended audience and circumstances under which they are 

reading the document. 

 Understand why this information is important to your audience. 

 Understand what your audience knows about the topic. 

 Use the active voice.  

 Write in the present tense.  

 Write using the third-person point of view.  

 Do not use the words will or should. 

 Write from an outline. 

 Use short sentences and short paragraphs. 

 Write at a sixth grade reading level. 

 Remove empty, cluttered and redundant language. 

 Schedule time to review the document with fresh eyes. 

 Use graphic devices to convey information effectively. 
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Language Style  
Planners apply professional editing standards to documentation and 

communication because much of it is official guidance and 
represents Texas to stakeholders and customers.  Look here for help 

with style and usage so that your writing is accurate, clear, 

consistent and professional.  

Our documents follow the conventions of standard written English. When there is 

more than one right way to write something, such as two-thirds and 2/3rds, we 
choose one way and stick with it. This is what editors, publishers and other 

communication professionals refer to as style. Following a consistent style reflects 
an attention to detail and helps build trust with our audience. Inconsistencies erode 
trust.  

The following guidelines present the language style standards for plans 

documentation and related communication. These guidelines are listed by topic in 
alphabetical order. Find corresponding visual style standards in the Visual Style and 
Formatting section. Remember too that you can search MS Word and most PDF 

documents by pressing Ctrl+F to display the search window. 

Abbreviations and Acronyms  
Abbreviations and acronyms, which are words formed with letters from a longer 
phrase, save time and space. Although they help specialists communicate quickly, 
abbreviations and acronyms usually confuse non-specialists. To help ensure 

communication is inclusive and widely accessible, use abbreviations sparingly. For 
more information, refer to the State of Texas Acronyms and Terms (STAT) book.  

Write the first appearance of an abbreviation in parentheses following the full name 
or term, as shown in the following example: 

In collaboration with state agencies and other stakeholders, the Texas 
Division of Emergency Management (TDEM) implements programs to 

increase public awareness. In addition, TDEM coordinates emergency 
planning and training.  

Start the process over at the beginning of each new section that begins with a main 
heading with a pull quote. For more information on section headings, refer to 

Design Elements below. 

Do not use abbreviations in headings or to start a sentence unless the abbreviation 
is well known or has already been used many times in the document. 

Use the singular form in first appearance: Letters of Agreement (LOA). Use the 
plural version, without an apostrophe, as needed after that: LOAs must be signed. 

If uncertain about an abbreviation’s correct form, refer to the STAT book, which 
contains most of the abbreviations and acronyms used in Texas emergency 

management planning.  
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Capitalization  
Whether to capitalize a word or not often depends on how it is being used. Use a 
capital letter only if necessary according to the following guidelines. 

Abbreviations and Acronyms 
The letters in abbreviations and acronyms are usually capitalized. You can confirm 
capitalization by referring to the STAT book.  

Names of Organizations Entities 
Capitalize words such as city, state or federal when used as part of an official name 

or title.  When such words stand alone, even if they refer to a particular entity, they 
appear lowercase, as is shown in the following table. 

Capitalize Lowercase 

Austin City Council She was the city’s longest serving mayor. 

This information appears in the State of 

Texas Emergency Management Plan. 

It is one of the state’s many defenses 

against emergencies and unforeseen 

incidents. 

It was presented by the Federal 

Emergency Management Agency. 

We researched federal guidance before we 

made our recommendation. 

Department, Division, Section or Unit 
Capitalize only when used as part of a name or title; otherwise, use lowercase as 
shown in the following table. 

Capitalize Lowercase 

Texas Department of Public Safety The department encompasses 16 divisions. 

Texas Division of Emergency Management The division maintains six satellite offices. 

The Preparedness Section is located in 

another building. 

Several members of this section were 

activated during the recent storm. 

The Local and Regional Plans Unit works 

with local emergency management 

planners. 

Members from this unit visit local and 

regional planners throughout the state. 
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Document Titles and Headings: The Four Letter Rule 
Follow these guidelines for capitalizing titles and headings. Here, capitalization 
means capitalizing the first letter of the word. Words in titles are never written in all 
caps unless the word is an acronym. 

Guideline Example 

Capitalize the first word, the last word, and 

the main words in between. 

 Engineering Principles and Practices 

 A Design Manual for Architects 

 The Benefits of Strategic Planning 

Capitalize conjunctions and prepositions of 

four or more letters. 

 Flooding and High Winds 

 Assistance or Referrals for Special Cases 

 Establish Security When Disaster Strikes 

 Preparing for a Drinking Water 

Emergency 

 Taking Shelter From Hurricanes 

These rules apply when a single title 

appears on two lines.  

A Field Manual 

for Incident Commanders 

However, titles and subtitles separated by 

a line break are treated as two separate 

titles.  

Incident Debris 

A Guide for Planners 

If the same title and subtitle appeared on 

one line, they would be separated by a 

colon. 

Incident Debris: A Guide for Planners 

Capitalize the first element of a 

hyphenated term. Capitalize subsequent 

elements unless they are articles, 

conjunctions or prepositions of less than 

four letters. 

 A Report on Counter-Terrorism 

Strategies 

 Addressing English-Speaking Residents 

 Monitoring Out-of-the-Way Locations 

  

Formal Titles 
Capitalize formal titles only when used as part of a person’s name, as shown in the 
table below. 

Capitalized Lowercase 

Chief Matthews The chief called the meeting. 

Captain Pat Matthews The captain attended the meeting.  

Pat Matthews, State Coordinator  Four state coordinators also attended. 

Pat Matthews, Unit Supervisor Five unit supervisors attended by phone. 
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Captions 
Write captions for all images, such as photos and illustrations. Captions are brief 
yet descriptive because screen-reading software reads them aloud to those with 

impaired vision. For more information on writing informative captions, refer to 
Accessible Images and Captions below. For more information on formatting 

captions, refer to Images and Captions below. 

Dates and Time 
Dates and time are expressed in a standard, familiar format. 

Dates 
Write dates in the month-day-year format as shown in the table below. When 
writing a month and year only, do not separate the two with a comma.  

Guideline  Example 

Write the month, day and year in standard 

format.  

 July 30, 2003 

 December 3, 1980 

 Friday, February 21, 2014 

When writing a month and year only, do 

not separate the two with a comma.  

 July 2003 

 December 1980 

 

Do not abbreviate the month or the day. Do not add “nd,” “rd” or “th” after the day. 

Standard  Non-Standard 

 Friday, February 21, 2014  

 February 21 

 Tuesday, December 3, 1980 

 Fri. 

 Feb. 21 

 Dec. 3, 1980 

 February 21 

 December 3, 1980 

 February 21st  

 December 3rd  

Meeting Date and Time 
Except for meeting invitations and notices to invitees, refer to meeting occurrence 
by date only. If the time and place changes, you need only update those who are 

involved. 

Time 
Write time according to the guidelines presented in the table below.  

Guideline  Example 

Specify time of day in 12-hour increments, 

either a.m. or p.m., rather than military 

time.   

 3:30 p.m. 

 3 p.m. 

 12:45 a.m. 

The designations a.m. and p.m. are written 

lowercase with periods and no spaces in 

between. 

 4:30 p.m. 

 4 p.m. 

 6:15 a.m. 
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Guideline  Example 

Use a colon to separate hours from 

minutes. It is not necessary to show 

minutes at the top of the hour. 

 10:25 p.m. 

 10 p.m. 

Indicate a time span by placing a hyphen, 

no space, between the two times. 

 4-5 p.m. 

 4:30-5 p.m. 

 8:30-9 a.m. 

Footnotes 
Insert footnotes after closing parenthesis if inserted in the middle of a sentence 

(like this)3 or after ending punctuation.4 Footnotes are also used to cross-reference 
information from a document that TDEM does not publish. For more information, 
refer to References below. 

Italics  
Use italics as described in the following table: 

Guideline  Example 

Titles of books, films and periodicals The July issue of Emergency Management 

Technical terms at first use The process of closing and securing the 

facility is known as decommissioning. 

Words as words, letters as letters and 

numbers as numbers 

Avoid using the term victim.  

All registration codes begin with the letter 

H followed by a 1, 2 or 3. 

Rarely, for emphasis if the emphasis is 

necessary and might otherwise be lost 

Cyberattacks are not the only threat, but 

they are the greatest threat. 

 

 
For more information on the distinctive treatment of words, refer to Font Styling in 
the Visual Style and Formatting section below. 

Lists  
Vertical lists, words that are stacked, flush left, follow certain language guidelines.  

Capitalization and Punctuation  
Capitalize the first letter of each list item regardless of whether or not it begins a 

sentence. If one or more items are complete sentences, end every item with a 
period; otherwise, do not end list items with periods. 

Levels 
Do not develop lists of more than two levels of indention.  

 

                                       
3 First example 
4 Second example 
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Introducing a List 
Introduce lists with a complete sentence that announces what is to come. Use 
words, such as “the following tasks” or “as outlined below,” followed by a colon. Do 
not introduce the list with the start of a sentence that is completed by each item in 

the list.   

Standard Non-Standard 

Each jurisdiction’s responsibilities include 

the following tasks: 

 Decision-making support or guidance 

 Perimeter security and access control 

 Providing reentry placard templates and 

guidance 

The responsibility for carrying out these 

tasks belongs to each jurisdiction and 

includes: 

 Decision-making support or guidance 

 Perimeter security and access control 

 Providing re-entry placard templates and 

guidance 

 

Parallel Construction 
In any given list, write the list items using the same (or parallel) sentence form. For 

example, make all the items on your list a declarative sentence or make them all 
questions, but don’t make some items declarative sentences and some questions or 

phrases or single words.  

Standard Non-Standard 

 Determine staff requirements. 

 Identify personnel who can fill 

emergency duty positions.  

 Train agency representatives according 

to NIMS requirements.  

 Develop and maintain contact lists. 

 Develop and maintain notification 

procedures. 

 Develop and maintain agency resources 

lists. 

 Have staff requirements been 

determined? 

 Agency personnel, as assigned, should 

identify specific personnel who can fill 

extended emergency duty positions. 

 Agency representatives should be 

trained in accordance with NIMS 

requirements.  

 Have contact lists, as well as notification 

procedures, developed and maintain 

them regularly. 

 Have your lists of agency resources been 

developed?  

Bullets Versus Numbered Lists 
List items, whether bulleted or numbered, only when there is more than one item. 
Bullets are most commonly used and do not imply sequence.  

Numbers are only used to imply sequence or order. Note that the information in 
extensive or complex numbered lists might best be presented as a process 

diagram. 

Do not use the MS Word list format on the Home tab. The Word default bullet style 
does not match ours. Instead, use the bullet or the numbered list quick styles in the 
template. For more information, refer to Bullets and Numbers in the Visual Style 

and Formatting section below. 
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Numbers 
Write numbers in a format that is familiar for most people or most members of a 
specialized audience. We follow more specific guidelines depending on how a given 

number is used.    

Numbers in Text 
In regular text, such as a paragraph or sentence, numbers one through nine are 

spelled out because this makes them easier to read. Write numbers 10 and greater 
as Arabic or Roman numerals. Roman numerals are used when part of a name, 
such as Region IV.  

Guideline  Example 

Spell out numbers one through nine.  Planners agreed on four objectives. 

 There are three basic strategies. 

Write numbers 10 and greater as Arabic 

numerals.  

 All 25 planning team members attended. 

 They sheltered more than 50,000 

evacuees. 

Numbers that begin a sentence must be 

spelled out except for years. 

 Twenty team members attended. 

 1965 was the last year of the drought. 

Exception: Some numbers are written as 

Roman numerals according to custom or as 

part of a name or title. 

 Region IV submitted the first request. 

 They discussed Implementation Phase V. 

An amount of less than one unit is 

considered singular. An amount greater 

than one unit is considered plural. 

 0.35 meter 

 0.55 cubic foot 

 1.75 kilometers 

 43.01 inches 

Exception: only use Arabic numerals and 

decimals with the word percent. 

 They exceeded the target by 23 percent. 

 The probability of this occurrence 

decreased by 0.09 percent. 

 

Numbers in Tables 
Numbers in tables follow specific rules for tabular data, as shown in the table 

below. For more information, refer to Tables below. 

Guideline  Example 

Use Arabic or Roman numerals only.   122 

 I, II, III, IV 

Convert fractions to decimals up to two 

places unless required to use more.  

 8.25 

 1.333 

For amounts less than 1, place a zero 

before the decimal point. 

 0.75 

 0.03 
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Plurals 
Plurals are normally formed by adding s, es, or ies according to correct spelling. 
Sometimes there is more than one standard form of pluralality. If this is the case 

we use the first listed plural spelling in the standard dictionary.5 Do not form a 
plural by adding ‘s, which forms a possessive, as discussed under Apostrophe 

below. 

Punctuation  
Use the Spell Check function in MS Word. If there is disagreement between Spell 

Check and this document, follow this document. 

Ampersand (&) 
Do not use ampersands, because they are not recognized by screen-reading 

software and therefore not accessible to the vision-impaired. For more information 
on accessible style guidelines, refer to Accessible Style below.  

Apostrophe 
In most cases, adding an apostrophe, followed by an s (‘s) forms the possessive 

case. Refer to The AP Stylebook. 

Commas 
Avoid unnecessary commas. Use the following guidelines to determine when to use 
commas.  

Commas in a Series 

Guideline  Example 

Use commas to separate elements in a 

series, but do not put a comma before the 

conjunction in a simple series. 

The resources included water, food and 

shelter. 

Exception: Use a comma before the 

concluding conjunction in a series; 

however, if an integral element of the 

series also requires a conjunction. 

The teams were trained in evacuation, 

search and rescue, and mass care. 

Use a comma before the concluding 

conjunction in a complex series of phrases. 

The main points to consider are whether 

the planning team includes all key 

stakeholders, whether members are able 

to attend all meetings, and whether they 

are prepared to contribute to the planning 

process. 

 

 

                                       
5 Find our standard dictionary, Webster’s New World College Dictionary, Fourth Edition, in 

the Plans Management library. 



26 Documentation Standards March 31, 2015 

 

Commas with Equal Adjectives 

Guideline  Example 

Use a comma to separate adjectives equal 

in rank; that is, if the comma could be 

replaced by the word and without changing 

meaning. 

an appropriate, effective response 

Use no comma when the last adjective 

before a noun outranks its predecessors 

because it is an integral element of a noun 

phrase. 

sustained wind speed (the noun phrase is 

wind speed) 

Commas with Nonessential Clauses or Phrases 
Use commas to set nonessential clauses or phrases apart from the rest of the 

sentence. Do not use commas to set off essential clauses or phrases. 

Commas with Introductory Clauses 

Guideline  Example 

Use to separate an introductory clause or 

phrase from the main clause. 

When the planner was ready to convene 

the planning team, she sent an email to all 

team members. 

The comma may be omitted after short 

introductory phrases if no ambiguity would 

result. 

During the first meeting they established 

the planning process. 

But use the comma if its omission would 

slow comprehension. 

In the meeting room, the planner 

answered questions. 

Commas with Conjunctions (Compound Sentences) 

Guideline  Example 

Use a comma before conjunctions like and, 

but or for when the conjunction links two 

clauses that could stand alone as separate 

sentences. 

Reception centers receive evacuees, and 

medics evaluate their needs. 

Use a comma if the subject of each clause 

is expressly stated. 

The lead agency has primary responsibility, 

and the lead agency communicates with 

supporting agencies. 

You do not need to use a comma with two 

short clauses that have expressly stated 

subjects. 

We are meeting and they are planning. 
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Dash 
Use a dash to set off a series of words that are separated by commas:  

Emergency Management Coordination at all levels — local, regional, state 

and federal — is outlined in the next section. 

Follow these guidelines when using dashes:  

 Create a dash using the MS Word keyboard shortcut Alt+Ctrl+Num-. The last key is 

the minus sign, which is located on the number keypad.  
 Insert one space on either side of a dash.  
 Do not use a hyphen instead of a dash. For more information, refer to Hyphen 

below.  

Hyphen 
Use hyphens in the following ways to clarify your meaning.  

Guideline  Examples 

Use hyphens to join two or more words 

into a single idea to help clarify meaning.  

 life-safety hazard 

 systems-tracking capability 

 large-scale hurricane 

 up-to-date situation reports 

You may use a hyphen to create a prefix 

after you have checked our standard 

dictionary for spelling6. If more than one 

spelling is provided, use the first-listed 

spelling. Refer to The AP Stylebook7 for 

rules on creating prefixes and suffixes. 

 pre-identified 

 sub-subparagraph 

 non-emergency 

 The damage is hurricane-related. 

Use a hyphen to indicate a span of time.  7-8:30 a.m. 

 7-10 p.m. 

Parentheses 
We avoid using parentheses because they can imply that the information they 

contain is nonessential. Consider using commas or revising the information so that 
parentheses are not necessary. If you must use parentheses, follow these 
guidelines: 

 Place end punctuation outside the closing parenthesis if the material inside the 

parentheses is not a sentence (such as this fragment). 
 (Place a period before the closing parenthesis of an independent parenthetical 

sentence, such as this one.) 

 Insert footnotes after closing parenthesis (like this)8 when the reference appears 
mid-sentence. 

                                       
6 Find our standard dictionary, Webster’s New World College Dictionary, Fourth Edition, in 

the Plans Management library.  
7 Find a copy of The AP Stylebook in the Plans Management library. 
8 Footnote example  
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Periods 
 Use a single space after the period. 
 Put periods inside quotation marks; use a single space after the quotation mark. 
 Do not add a period to the end of a sentence that already ends with an abbreviation 

ending in a period. 

Possessives 
Refer to Apostrophe above. 

Quotation Marks 
 Use open-quote marks (“) and close-quote marks (”) to surround quoted material. 

 A word or words being introduced to readers may be placed in quotation marks on 
first reference. Do not put subsequent references in quotations. 

 The period and the comma always go within the quotation marks. 
 Put other forms of punctuation inside quotation marks if the punctuation applies 

only to the quoted matter. Put other forms of punctuation outside quotation marks 

if the punctuation applies to the whole sentence.  

Semicolon 
Use the semicolon to indicate a greater separation of thought and information than 
a comma can convey, but less than the separation that a period implies. 

Guideline  Examples 

Use semicolons to separate a series when 

the items are long or when individual 

segments must be set off by commas. 

The plan details roles and responsibilities; 

provides step-by-step guidance; and 

facilitates communication between local, 

regional, tribal, state and federal partners. 

Use a semicolon when a coordinating 

conjunction, such as and, but or for, is not 

present. 

The fuel coordination team initiated the 

conference call; it started on time. 

Slash 
 Use 24/7 to mean 24 hours a day, seven days a week. 
 Use with fractions and in Internet URLs. 

 Minimize your use of and/or by deciding whether you mean “and” or “or.”  
 Do not add spaces on either side of a slash. 

References 
In plan documents, we often reference information that appears elsewhere in the 
document or in another document altogether. We format references according to 

the type and location of the source, as shown below. 

Reference Type  Reference Format 

Cross-reference within the same document In-text, italics, document color 

Reference to another plan document  Reference Arrow, footnote, document color 

Reference to any other outside source Footnote and bibliographic entry 



March 31, 2015 Documentation Standards 29 

The format for each type of reference is described in detail below, including 
variations for using hyperlinks and electronic sources.  These formats are loosely 

based on The Chicago Manual of Style footnote and bibliographic documentation 
style, modified substantially to meet planner and end-user needs. 

Standard Reference Wording 
Use the following standard wording to introduce references either in running text or 

in a footnote: 

 For more information, refer to [x]. 

or 

 For more information on [y], refer to [z]. 

References Within the Same Document 
To reference information elsewhere in the same document, write the name of the 

section or heading in italics and give it the document color, as in the following 
example. 

 

References to Other Plan Documents: The Reference Arrow  
To reference information in another plan document, such as another annex, use the 

reference arrow. This device saves space, reduces clutter and avoids interruption. 
The reference arrow alerts the reader that a direct reference to another relevant 

document appears at the bottom of the page, as shown in the following example.  

 

The reference arrow saves space only when making an indirect in-text reference to 
another plan document. If you must refer to the other plan document by its name 

in running text, do not use the reference arrow. 
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To insert a reference arrow, use the footnote feature in Word. First, decide where 
the in-text footnote reference appears. Position your cursor after the word or 

phrase and any nearby punctuation, such as a comma or a period. Then, insert and 
format the arrow following these steps: 

1. In the Ribbon, choose “References.” 
2. Open the “Footnotes” section. 

3. Under “Format,” choose “Symbol.” 
4. Under “Font,” choose “Wingdings.” 

5. Navigate to the “Wingdings 228” arrow and click “Insert.” 
6. In your document, highlight the arrow superscript. 
7. Change the font to Calibri, 10 pt. and deselect the superscript format.  

8. Apply the referenced document’s document color. 
 

In the footnote field that opens at the bottom of the page, enter the text of the 
footnote. Style the reference arrow as you did for the in-text reference. Give the 
entire footnote the other document’s color. Style the title of the other document in 

bold and hyperlink this title to the other document.  

For more information on formatting, refer to Visual Style and Formatting below. 

If you find yourself including more than two reference arrows on a given page, 

recast the text to avoid so many appearances of the arrow in one place. Consider 
using a table or some other device that collects all these references together in the 

main body of the text. 

References to Outside Information Sources 
References to outside sources help substantiate and validate the information we 
publish. In plan documents, references to outside information sources are styled as 

footnotes at point of use and appear as bibliographic entries on the “References” 
page.  

Because we use a modified footnote and bibliographic style, we do not use the 
“Insert Citation” feature in MS Word. Instead, we enter bibliographic information 

into Word in the “Manage Sources” function. Complete instructions for doing so 
appear below. Before entering bibliographic information, however, you must know 
the following about each of your sources: 

 What type of source is it? 

 How is it used? 
 Will it be hyperlinked? 

Types of Outside Sources 
As your document develops, keep your source information handy so you can enter 

it into MS Word’s format for managing references. Use the following table to help 
you decide how each source is to be treated.  
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Reference Source Drop-Down Format Keep in Mind  

State laws and governmental 

codes 

N/A Enter these references on the 

“Authority” page. For more 

information, refer to Authority 

below. 

Books, including dictionaries, 

encyclopedias and multi-

volume works that are not 

journals or periodicals 

“Book” Choose “Book.” Avoid self-

published, vanity press or 

little-known industry 

association publishers. 

Professional, academic or 

trade journal articles 
“Journal Article” Many journals are peer 

reviewed and have high 

editorial standards. 

Popular magazine and 

newspaper articles 

“Article in a Periodical” Cite established publications 

with high journalistic 

standards. 

Published information 

accessed online 

“Document From 

Website” 

Use information that has been 

evaluated by a reliable source. 

Information that is unavailable 

in traditional print format but 

is available on a 

governmental, agency or 

educational institution’s 

website 

“Electronic Source” Use information that has been 

evaluated by a reliable source. 

 

If unsure about which bibliographic format to use, ask the Plans Management unit. 

Avoid unpublished information or information that does not fit into any of these 
categories. 

How to Footnote Outside Sources 
Part of using sources well means introducing them at point of use correctly, 
consistently and unobtrusively. To insert a footnote to an outside source, use the 
footnote feature in Word. First, decide where the in-text footnote reference is to 

appear. Position your cursor after the word or phrase and any nearby punctuation, 
such as a comma or a period. Then, insert the footnote following these steps:  

1. In the Ribbon, choose “References.” 
2. Choose “Insert Footnote.” 

3. Enter the text of the footnote in the field that opens at the bottom of the page. 
4. Follow these steps to insert a footnote in your MS Word document:  
5. Position your cursor where you want the superscript footnote number to appear. 

6. In the Ribbon, select the “References” tab. 
7. Choose “Insert Footnote.” 

8. Click “Insert.” 

                                       
 For more information on researching governing legislation, refer to the Legislation 

Navigation Guide. 
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A superscript number appears, and a corresponding number and space appears at 

the bottom of the page where you can type the text of your footnote. 

The text of the footnote begins with our standard reference wording, “For more 
information, refer to. . . .” or “For more information on [x], refer to. . . .”   

Follow this introduction with a brief but useful reference to the author or institution 
and title of the work or article. To be useful, the reference includes just enough 

information to connect it with the full bibliographical reference on the References 
page.  

If you wish to include an author’s name in the footnote, write the author’s name in 
natural order, rather than last-name-first-name bibliographic order. 

If the source includes a hyperlink, include the link behind the title of the work. The 
bibliographic entry on the References page reproduces the full URL without the link. 

Consider the following examples:  

Footnote 

5For more information, refer to The National Drought Mitigation Center, Types of 

Drought. 

Bibliographic Entry on References Page 

University of Nebraska-Lincoln: The National Drought Mitigation Center. Types of 

Drought. 2014. http://drought.unl.edu/DroughtBasics/TypesofDrought.aspx. 

Creating Bibliographic Entries for the References Page 
To create bibliographic entries that reflect the sources in your footnotes, use the 
“Manage Sources” feature in MS Word. By entering the source information here, 

Word auto-generates the “References” page that appears at the back of your 
document. To begin using this feature, follow these steps: 

1. In your document, select the “References” tab in the ribbon. 
2. Under “Citations & Bibliography,” open the “Style” drop-down menu. 

3. Choose “Chicago Fifteenth Edition.” 
4. Choose “Manage Sources.” 

5. In the “Source Manager” window that opens, look for a matching source. 
6. If no matching entry exists, add “New.” 
7. In the “Create Source” window that opens, choose “Type of Source.” 

8. Fill in the form fields with information about the source. 
9. Save and then check the newly created source for accuracy. 

At this point, enter full bibliographic information about the source. When the source 
includes a web address, spell out the fully qualified URL, which includes “http” or 
“https,” but do not make this a hyperlink.  
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References Page 
Once you have drafted your document and entered your sources and citations, you 
can auto-generate the “References” page. To do this, follow these steps: 

1. Position your cursor where the Reference page is to appear. 
2. Select the “References” tab in the ribbon. 
3. Open the “Bibliography” drop-down menu. 

4. Choose “Insert Bibliography.”  
 

Following these steps generates the “References” page according to our 
bibliographic style. Remember to be sure that the bibliographic style selected in 

your document is “Chicago.” 

Referencing Legislative Statutes 
The Authorities page of our plan documents includes a table of legal authorities, 
usually a legislative statute, that authorize the development of our plans. Follow the 

format of existing plans, as well as the document template. 

Web Pages, Hyperlinks and Websites 
Use the footnote function in Word to insert links to web pages managed by outside 
sources cited in the document. Include them in the References page. All references, 

with or without embedded hyperlinks, to another organization’s web content refers 
the user to the organization’s website, as shown below: 

For more information, refer to Continuity of Operations Capabilities on the FEMA 
website. 

Tables 
Tables are used whenever it is possible to clarify or simplify information by putting 

it into tabular format. A table clarifies or efficiently communicates information in a 
matrix, the result of data on one dimension intersecting data along another. By our 
definition, a table is any presentation of information made up of rows and columns. 

Plan documents contain several predefined tables that are filled in with data 
collected from stakeholders during the planning process. Sometimes, however, the 

need for a table arises from the text itself. Often, this happens when discussing 
facts or conditions that can undergo significant changes depending on other factors. 

Rather than describing possible combinations in several paragraphs, consider 
showing them in a table. 

If it is not obvious how to present the information in a table, or there are several 
possible ways, try drafting some alternatives. Test them out before you devote too 

much time to a single solution. To help organize your approach to the information, 
try following these steps:  

 

 

                                       
 For more information, refer to the Legislation Navigation Guide. 

http://www.fema.gov/continuity-operations/continuity-operations-capabilities


34 Documentation Standards March 31, 2015 

1. List the different ways the information can be broken into categories. 
2. Check that all the information sorts into categories and nothing is left out. 

3. Rank order the list of categories. 
4. Make a table with the most important across the top and the second most 

important down the side. 
5. Begin filling out the table, noting whether anything critical is lost.  
6. If important information is lost, revise your categories and draft a new table. 

 
So that screen-readers for the sight-impaired can translate the content of tables 

into a voice recording, do not merge cells. This includes headers. The titles of tables 
appear in the first column of the first row, or they can appear as a subhead above 
the table, always followed by a sentence or two of text. Often, a table is preceded 

by an introductory phrase such as “. . . as shown in the table below” or “. . . as 
outlined in the following table.”  

The plan document templates include the tables that we use most often and which 
you may copy to create others. To create a new table, choose the “Insert” tab in 

the ribbon and click the “Table” drop-down menu. Follow the prompts to create 
your table and use the Quick Styles to style it.  

For more information on how to format a table, refer to Tables in the Visual Style 
and Formatting section below. For more information on tables and accessibility, 

refer to the Accessible Style section below. 

Tense 
Write in the present tense, using the present tense form of verbs. The use of the 
future tense is inappropriate for communication that compels action, such as a field 
manual or standard operating procedures (SOP) guide. Also, it is often 

inconsistently applied, which leads to confusion about procedures, sequence and 
timing. For more information, refer to Tense under Know the Audience above. 
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Language Style Checklist 
Use this checklist to help you check that your document follows our language style.  

                   Language Style Checklist 

 Abbreviations and acronyms are used correctly and consistently. 

 Words are capitalized according to style. 

 Dates and times are properly formatted. 

 Lists are properly and consistently formatted. 

 Numbers are properly and consistently formatted. 

 Punctuation is used correctly and consistently according to style. 

 References and the References page is formatted properly. 

 Tables are styled appropriately and consistently. 
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Common Planning Terms and Usage  
Use the following list to learn the standard form and usage of commonly used 
terms. Although this list is not a comprehensive glossary or list of abbreviations↗, it 

does address many of the terms that appear in our documents.   

Annex/Appendix/Attachment 
These three words mean different things to different audiences. The following table 

explains how we use these words in our plan documents. 

Word Usage 

Annex To describe a separate document that stands alone, but has direct 

relevance to the main document and may be written by a separate 

author. 

Appendix To describe reference information at the end of a document that does not 

stand alone and does not need to be read to understand the main 

document. 

Attachment To describe something not included in the document itself, but attached 

as a standalone form added to the document. 

 

CBRNE  
Use CBRNE, not CBRN, for chemical, biological, radiological, nuclear or explosives. 

COOP  
Continuity of Operations. Recovering and restoring an organization’s essential 
functions, as distinct from emergency response and recovery.  

COOP Unit 
Continuity of Operations Unit. Capitalize “unit” when it is included as part of the 
title. Lowercase “unit” when it is not written as part of a title, as in “The unit sent a 
representative to the meeting.” 

Deactivate  
Deactivate is preferred over inactivate. 

Decision-making, Decision-maker 
Hyphenate when used as a compound modifier.  

DoD 
Department of Defense. Small o. 

                                       
↗ For a complete list of abbreviations and glossary of terms, refer to the State of Texas 

Acronyms and Terms (STAT) Book. 

 For more information on COOP planning, refer to the DPS Continuity of Operations 

Agency Plan. 

http://www.txdps.state.tx.us/dem/documents/planState/STAT.pdf
http://www.txdps.state.tx.us/dem/documents/planState/STAT.pdf
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DPS 
Abbreviation for Texas Department of Public Safety. Do not show as TxDPS or 
TXDPS. In agency lists that include TDEM, show as “DPS-TDEM.” Follow TDEM with 
a hyphen and section or unit name as needed. 

ePlan 
The TDEM Emergency Plan Management System, which enables emergency 
coordinators across the state to submit emergency plans to TDEM.  

ESF-1  
Use the hyphen, no space. Federal documents often use the pound symbol (#), 

prior to the first digit. We do not. 

ETN 
Emergency Tracking Network; Formerly Texas Emergency Tracking Network 
(TxETN) 

Evacuee(s) 
Avoid this term since it may not be an accurate description people can be affected 
by an incident without being evacuees. Use “people affected by the [incident]” 
instead.  

FEMA Regions 
Use Roman numerals, such as I, II, III, when referring to FEMA regions. 

Full-Scale 
Hyphenated, as in full-scale exercise. 

Green Book 
Introduce as the ESF Crosswalk Reference Guide (Green Book), and use Green 

Book thereafter. As with acronyms, reintroduce in new sections. 

Inactivate 
We prefer deactivate over inactivate. See Deactivate above. 

Interjurisdictional 

Do not hyphenate. 

Local and Regional Plans Unit 
Do not use LRPU except in internal or informal communication. Capitalize “unit” 

when it is included as part of the title. Lowercase “unit” when it is not written as 
part of a title, as in “The unit sent a representative to the meeting.” 

More than versus over 
To express quantities, use more than: 

“They sheltered more than 15,000 evacuees.” 

Over refers to relative position.  
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Multi-agency  
Hyphenate. 

Multijurisdictional  
Do not hyphenate. 

Over 
See More than versus over. 

Planning team 
A generic reference to the people who work with us on our annexes. 

Plans team 
A specific reference to the Local and Regional Plans Unit, the State and Federal 
Plans Unit, the Plans Management Unit and the Continuity of Operations Unit. 
Capitalize Plans team as the informal name of a specific group. 

Population, residents 
Use “population” to refer to a large, general group. Use residents, rarely, to refer to 
individuals living in a geographic location. 

Predesignated 
Do not hyphenate. 

Pre-identified  
Hyphenate. 

Should 
Does not appear in the State of Texas Emergency Management Plan or its annexes 
because these documents are not prescriptive. Local guidance documents may use 

“should” when necessary. 

SITREP 
Abbreviation for situation report.  

State and Federal Plans Unit 
Do not use SFPU except in internal or informal communication. Capitalize “unit” 

when it is included as part of the title. Lowercase “unit” when it is not written as 
part of a title, as in “The unit sent a representative to the meeting.” 

Storm Names 
Use storm names provided by National Oceanic and Atmospheric Administration 

(NOAA). 

Tabletop 
One word, as in tabletop exercise. 

TTE 
Abbreviation for test, training and exercise. 



March 31, 2015 Documentation Standards 39 

Texas A&M AgriLife Extension Service 
Note capital L in AgriLife. 

Texas Division of Emergency Management (TDEM)  
Do not write out as “Texas Department of Public Safety—Division of Emergency 
Management.” Write as “DPS-TDEM.” 

Texas Highway Patrol 
Do not write Texas Department of Public Safety—Highway Patrol. Spelled out, write 

Texas Highway Patrol; however, the short form is DPS-THP. 

TSA 
Abbreviation for The Salvation Army; do not abbreviate as SA. 

Tribal 
Include the word tribal everywhere we write the words federal, state and local. For 

example: Federal, state, tribal and local jurisdictions are invited to comment. 

TxDOT  
Use lowercase x per TxDOT’s preference.  

TxETN 
Do not use. Refer to ETN above. 

TXMF 
Texas Military Forces. 

U.S.  
Use with periods or, rarely, USA without periods. 

Utilize 
Do not use. In most cases, the word use is sufficient. 

Victim(s) 
Do not use. Instead refer to people (or the population) affected by [the disaster]. 

Website 
One word. Use to refer to Web content provided by another organization. For more 
information, refer to Web Pages, Hyperlinks and Websites in References above. 

Wildland fire  
Wildland fire is preferred over wildfire. These terms are not interchangeable.↗  

Will 
Do not use. Use the present tense “are” or “is.” For more information, refer to 

Tense above.  

                                       
↗ For more information, refer to the Firefighting Annex of the State of Texas Emergency 

Management Plan. 

http://www.txdps.state.tx.us/dem/documents/planState/STAT.pdf
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Visual Style and Formatting 
This section presents standards and guidelines for using graphics 

and images to develop effective, user-friendly documentation. 

Our document layout and design standards were developed for clarity and 
accessibility. Specific colors and fonts were selected to ensure that our products 

present a strong and consistent identity to internal and external audiences. A 
consistent image, or brand, communicates authenticity, indicates quality and 
inspires trust. The Plans team brand aligns with the TDEM brand. 

As a team we strive to be: 

 Inclusive 
 Collaborative 

 Forward-facing 
 Standard-setting 

 Innovative 
 Helpful 
 Knowledgeable 

Our products reflect our brand and are: 

 Accessible 
 Available in multiple formats 

 Easy to navigate 
 Clear 
 User-friendly 

The program design for plan documentation meets the following objectives:  

 Visually clear and uncluttered, connoting authority and trustworthiness  
 Accessible according to 508 guidelines 

 Flexible enough to accommodate a wide array of document types and design 
problems 

 Easily implemented with a basic word processing program 
 Easily maintained 
 Easily used by non-specialists  

Often the design is determined by the default settings of the software. For example, 
the page margins are one inch on all sides, which is the default MS Word margin 

setting. 
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Design Elements  
Our documents rely on a variety of design elements and features to achieve a clear, 
accessible and user-friendly look. The following table shows how each element 

contributes to our overall effect. 

Design Element Rationale 

Alignment and 

Layout 

For the most part, text is set flush left, ragged right, top aligned 

because it is the most familiar and the easiest to manipulate. The 

text block is set this way. Exceptions are rare and intentional to 

support branding or provide visual relief. Pages are top aligned and 

ragged bottom to facilitate the “chunking” of information and open 

up the page layout overall. A whiter, more open page helps prevent 

the user from feeling overwhelmed by the content. 

Borders and 

Rules 

Borders, also known as rules, are used to separate sections of text 

and within tables for ease of navigation. They are used sparingly.  

Bullets and 

Numbers 

Bullets and numbers are used to set off items in vertical lists. 

Bullets and numbers sit outside the text block so that the eye 

quickly navigates to the content that the bullet or number 

highlights.  

Color Palette Color is used when it serves a functional purpose. One dominant 

color is selected for each of four plan document types. This aids 

document identification, readability and cross-referencing. Color is 

used in a way that does not cause problems for colorblind users 

and is discernable in a variety of formats, media and reading 

conditions. 

Diagrams  Diagrams and process flowcharts are used to present important or 

complex procedural information and to reinforce written text. A 

standard software tool and a simple, familiar symbol system are 

used to facilitate understanding. 

Fonts To help streamline reading and to support the use of reading assist 

software for the visually impaired, all planning documentation uses 

the type font Verdana, an industry standard for clarity and 

legibility. We use Calibri-Wingding for the cross-reference arrow 

icon. Fonts in table headers are reversed out (white) of the 

document color to help distinguish the header from the rest of the 

table. Within documents, font sizes range from 18 pt. for the 

section headers to 10 pt. for table text. The main text font is 11 

pt., which is within 508 accessibility recommendations. We do not 

underscore, all-cap or boldface words for emphasis and rarely use 

italics for this purpose. 

Images and 

Captions 

Images, such as photographs and illustrations, are used sparingly 

and when used convey important information. They are not used in 

a purely illustrative or decorative way. Captions briefly describe the 

information conveyed by the image. 
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Design Element Rationale 

Navigation 

Devices 

All documents employ navigation tools that help the user find 

content within the document and locating additional content outside 

the document. Examples include the reference arrow, the planning 

document color palette, and pull quotes. 

Pull Quotes Pull quotes are set in a large boldface font just beneath the section 

heading (H1). Highlighting this information allows the reader to 

quickly preview the content of the section. 

Section Headings Section headings clearly announce the beginning of the primary 

sections in any document. They appear in a large, bold font and are 

followed by a pull quote and a rule. 

Tables Tables are used to clarify and streamline information. Tables are 

“open” and contain as few hyphenated words or widows as 

possible. Column widths are standardized or are distinctly different 

to maintain clarity. A menu of table styles has been developed to 

maintain a consistent style and brand, as well as to ensure their 

appearance remains as clear and open as comprehension allows.  

 

The remainder of this section provides guidelines for many of the design elements 

in the table above, as well as for other important elements of visual design and 
communication. 

Alignment and Page Layout 
Page margins maintain the MS Word default setting of one inch (1”) on all sides. 

The main text block is set flush left, ragged right. The preferred width is six-and-
one-half inches (6.5”). This width applies to tables, borders and rules also. 

Pages are set top aligned, ragged bottom, which means that the text block need 
not touch the bottom margin of the page. This gives planners the flexibility to shift 

a heading from the bottom of one page onto the top of the next to prevent a bad 
break. Avoiding such discontinuities facilitates the “chunking” of information while 

opening up the pages overall.  

Bullets and numbers sit outside the text block in the left margin. This is because 

the eye more easily absorbs information that aligns on a clean, vertical edge than if 
the content itself is indented.   

Titles as they appear on covers and title pages are set flush right as a consistent 
branding element. In some tables, the text in the first column is set flush right to 

highlight or make a distinction about the information in the first column or simply to 
aid reading and navigation.  

Removing Bad Breaks 
As a document nears its final review stage, the planner scans it for bad page 

breaks. These are pages with a major heading on the last line or just a few lines of 
type at the top of the page. Look for a logical break and insert enough line spaces 
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or a page break to remove the bad break. It may save time to reduce the document 
size on your screen to 50 or 60% so that it is easier to scroll through and spot bad 

breaks.  

Another way to remove a bad page break is to edit the copy so that it fits in the 
appropriate place. Use this approach to edit tables and diagrams to fit a given 
space so that there is a natural break and big chunks of content hold together 

visually. Remember that every time content is added to or subtracted from a 
document, it must be quickly scanned for any newly created bad breaks.  

Borders and Rules 
Borders and rules, or lines, are the main graphic elements that separate text. Apart 
from covers, documents use two standard line weights: ¾ point and 2 ¼ point. 

The ¾ point line is mainly used in tables and Visio diagrams. Horizontal lines are 

used to open up the table and the page, as in the following example. If possible we 
do not use vertical divider lines or outlines unless they are necessary for clarity. 

The ¾ point line is used in tables and Visio diagrams. Horizontal lines are used to 
open up the table and the page, as in the following example. If possible we do not 
use vertical divider lines or outlines unless they are essential for clarity. 

 

 

The 2 ¼ point line is used with pull quotes in the section header to separate it from 
the text that follows, as shown in the following example. 
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Bullets and Numbers  
Bullets and numbers are used to make vertical lists easier to find and read. Bullets 

and numbers never begin a main section, but are usually introduced by normal 
text. For more information on writing and punctuating bulleted and numbered lists, 

refer to Lists above.  

Numbers are used in lists only when the numbers denote sequence, as in a series 

of steps. Use no more than nine steps and few, if any, subordinate steps. Often 
more complex processes are best presented in a diagram.  

Bulleted or numbered lists are no more than two levels deep. 

The bullets and numbers themselves are set in the left margin so the content aligns 
flush left with the rest of the text block. This alignment is necessary because it is 
easiest for the eye to absorb information that aligns on a clean, vertical edge. 

Usually bullets and numbers are preceded and followed by one line space. They 

appear in the document color and serve as navigation devices within the document 
itself. Bullets and numbers are provided as Quick Styles in all our templates. 

Color Palette  
Our documentation draws on six colors that together brand and distinguish a wide 
array of document types and information. These colors satisfy the following criteria:   

Utility 
 Clearly distinct colors 

 Meet Section 508 accessibility guideline criteria for color blindness/contrast 
 Web-safe, easily adapted to a broad range of viewing environments 

 Strong enough to remain distinct across a wide range of shades and tints  

Meaning and Symbolism 
 Unite with the typographic design to communicate specific, positive values 
 Separately and together help communicate the tone and ethos of the agency  

 Do not carry unintended or problematic connotations  
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Four specific colors, known as the primary color palette, are used to identify and 
distinguish among the following four basic types of documents and communication: 

 Foundation plans, stand-alone, and internal/external communication 

 Hazard annexes 
 Essential Support Function (ESF) annexes 
 Support Function (SF) annexes 

Two additional colors—a secondary color and a tertiary color—are used as needed 

in any document to distinguish, call out or color-code information in a way that is 
visibly distinct from each color in the primary color palette.  

Local and regional plan documents that originate with TDEM take the color of a 
relevant or related state-level document or take Planning Blue. 

 

Primary Color Palette 

 

 

 

Planning Blue RGB 0, 51, 153 

To be used with most of our documents. 
Rationale: When used with official communication and symbolism, blue has mainly 

positive connotations, such as authority, patriotism, honor and trust. This blue 
closely matches the blue in the Texas and the U.S. flags. 

 
Examples 
 

 Foundation plans, such as the State of Texas Emergency Management Plan 
 External, stand-alone documents, such as the STAT book 

 External communication, such as the Planning Update 
 Internal documents and communication, such as our Documentation Standards 

 

 
 

 
 

Hazard Red  RGB 153, 0, 51 

To be used for Hazard and Threat annexes 

Rationale: Red is associated with emergency, danger, hazard and rapid response. 
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ESF Gold   RGB 153, 102, 0 

To be used for Essential Support Function (ESF) annexes  

Rationale: Gold and yellow connote significance as well as warning. 
 

 
 
 

 

SF Green  RGB 0, 153, 102 

To be used for Support Function (SF) annexes  
Rationale: Green is not associated with emergency, danger or warning, and in this 

context is meant to connote additional support, reassurance and deliberation. 
 

Tints 

Tints, or colors mixed with white, multiply the range of options available from a 

single color. For example, just as the color pink is a tint of red, we can make two or 
three additional and distinct colors by mixing any of the primary palette colors with 
white.  

 
Here, each of the primary colors is shown as a 25% tint, overprinted with 10 pt. 

Verdana: 
 

 

 

 

Secondary and Tertiary Color Palette 
These colors have the following characteristics: 
 

 Clearly distinct from the primary color palette, especially when formatted as normal 
text 

 Easy for everyone to find and use as needed 
 Carry no awkward or unintended meanings or connotations 

 

  

Planning 

Blue 

Hazard 

Red 
ESF 

Gold 
SF 

Green 
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Secondary Red 

Secondary Red is used mainly in running text but also in graphics and headings as 

necessary. Between red and blue, red is the most visible and connotes more 
urgency than blue. 

 
Example text: The State Drought Preparedness Council has been at the forefront of 
the state’s drought response since record-breaking drought year 2011. In 2013 the 

Texas legislature added the Public Utilities Commission of Texas (PUC) and the 
Electric Reliability Council of Texas (ERCOT) to the council.   

 
 
 

Tertiary Blue 

Tertiary Blue is used mainly in running text but also in graphics and headings as 
necessary. Blue is somewhat less visible than red and connotes less urgency. 

 
Example text: The State Drought Preparedness Council has been at the forefront of 
the state’s drought response since record-breaking drought year 2011. In 2013 the 

Texas legislature added the Public Utilities Commission of Texas (PUC) and the 
Electric Reliability Council of Texas (ERCOT) to the council. 

Choosing and Changing Colors 
Secondary Red and Tertiary Blue can be selected from the main “standard colors” 
drop-down menus in MS Word and Excel. 

To change the color of text, follow these steps:  

1. Highlight the text. 

2. On the home ribbon, choose the “font color” drop-down menu. 
3. Choose “More Colors.” 

4. Open the “Custom” tab. 
5. Make sure “RGB” appears in the “Color model” drop-down menu. 
6. Enter the desired color’s RGB numbers into the Red, Green and Blue text fields.  

7. Press “Enter” and the text changes color. 
 

Diagrams  
Planners create pictures, or diagrams, of complex processes and relationships, 
using the common software tool Microsoft Visio and a standard set of symbols.  

 

 



48 Documentation Standards March 31, 2015 

Process Diagram Basics 
Process diagrams, or flowcharts, are oriented first by time, which flows down the 
page, and then by functions or agents, which are arrayed across the top of the 
page.  Vertical columns, or “swim lanes,” mark off each agent’s area of 

responsibility or control, as shown in the following example. 

 

The shapes in the swim lanes represent activities, decisions or documents. They are 
connected by lines that indicate the process flow. The following table defines each 

shape and how it is used.     
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Creating Diagrams in Visio 
Formatting generally follows our style for tables, as reflected in the following basic 

settings:  

 Headers and titles are set in Verdana, 11 pt., bold, white, on document color.  

 Text within the diagram is set in Verdana, 10 pt., or 9 pt., at minimum.  
 The “yes” and “no” text at decision points is set in Verdana, 9 pt. 

When you create a Visio diagram, think about its final size in the document. Visio 
tries to fit the file in the space available, which may reduce font and line sizes to 

near illegibility. Diagrams are not more than six inches wide or eight inches deep.  
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When you open Visio to create a file, the program prompts you to make some 
format choices. Choose the following options:  

 Choose cross-functional with band orientation set to vertical. 

 In each band, list each function or agent in the function boxes. 
 Use the y-axis for time. 
 Use the x-axis for function. 

 Use the Basic Flowchart Shapes, in U.S. units, in the flowchart shape menu.   
 Use Classic small border, without a background, as a frame. 

 The outside border is in the document color, 0.75 pt.  
 Color can be adjusted under format > line > color.  
 Line weight can be adjusted under format > line > weight > custom. 

 Terminator oval shapes are Verdana, 10 pt., bold, white, on document color. 
 

Note that some Visio diagrams that appear in our plan documents do not follow this 
format. As these documents are revised, however, these diagrams are updated to 
match style. 

Inserting, Linking and Updating Diagrams in Plan Documents 
Unlike charts and tables, Visio diagram files are treated as source files and are 
stored in a separate graphics folder within the document’s file folder structure. In 
the plan document, we insert a link to the Visio source file so that a copy of the 

diagram appears in the document. To do this, follow these steps: 

1. Position your cursor where the diagram is to appear in the document. 
2. On the Insert tab, select “Object” from the Text section. 
3. Select the “Create from File” tab. 

4. Click “Browse” and navigate to the Visio file. 
5. Select the file and click the “Link to file” box.  

 
Changes to Visio source files do not automatically push to all linked objects in all 
documents.  To update a Visio object in a document, follow these steps: 

1. Right click the Visio object in the document. 

2. Choose either “Update link” to update the object or “Linked Visio Object” > “Open 
link” to compare the object with the source file. 
 

To share copies of a Visio diagram outside your immediate work group, save a copy 
of the source file in another file format, such as TIFF or JPEG, so there is no danger 

of compromising the source file. 

Fonts  
To help streamline reading and simplify document preparation, the standard type 

font for all planning documentation is Verdana. This versatile font has become an 
industry standard for legibility and readability. Also, it responds to Section 508 of 

the Rehabilitation Act of 1973, which helps ensure our documents are accessible to 
the entire community of potential users. For more information on Section 508 
compliance, refer to Accessible Style below. We do not underscore, all-cap, small 

cap, or boldface words for emphasis.  
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Font Color 
Body text is black. Headings are set in the document color. Any text may be set in 
a secondary or tertiary color, as prescribed. For more information on the colors 
used in planning documentation, refer to Color Palette above. Fonts in table 

headers are boldface white (reverse) against the document color to help distinguish 
the header from the rest of the table.  

Font Size 
Within documents, font sizes range from 9 pt. in Visio diagrams to 18 pt. for the 

section headers. The main text font is 11 pt., which complies with Section 508 
accessibility recommendations.  

Font Styles and Formatting 
We use Word document templates to create different types of documents. These 
templates are preformatted with Quick Styles selected from the “Styles” menu on 
the Ribbon. The document templates identify the style by name and provide 

additional guidance about using them. 

Since these styles are built into the templates, you do not need to know the style 

settings themselves; however, it is essential that you apply quick styles properly in 
order to produce a correct, internally-consistent and professional document. For 

more information, refer to Appendix A: Format Settings. 

Font Styling  
Using the templates means you do less font styling on your own. Following are 
basic guidelines about styles to avoid and the special treatment of words. 

Do not use the following text formats: 

 Boldface except in references 
 Italics except as guided 

 Underscore 
 Strikethrough 
 Highlighting  

 Colors except as guided 

For more information on using boldface in references, refer to References above. 
For more information on using italics, refer to Italics above. 

To check whether your headings are correctly styled, update your document’s table 
of contents. Compare the table of contents headings to those in the rest of the 

document, as well as an example of a similar document. Make sure your table of 
contents is complete and correct: nothing added, nothing missing. 
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Images and Captions 
By images, we mean photographs, illustrations, some charts and other forms of 
graphic art that are prepared by others or come from an outside source. Diagrams 

and Maps are discussed separately.  

We use images sparingly. Photographs usually enliven a document, but in our 
documents they also convey information. Photographs and illustrations from outside 
sources are usually expensive and protected by copyright. Photo permission and 

source information must be documented, so be sure the photograph is essential. 

Keep the following points in mind as you develop and add images to your 
document: 

 Document the image’s source, whether internal, from another source, or from our 
image library. 

 Keep a file with information on who gave written permission to use it, when and 
under what circumstances. 

 Do not assume an image is in the public domain (freely available) or that it may be 

used without permission because it appears in a government publication.  
 Speak with your supervisor before commissioning artwork. 

 Avoid images with corporate names and logos unless these are essential to the 
image’s meaning and value. 

Appearance and Layout of Images 
Images are included when they convey useful or contextual information. Follow 

these guidelines for ensuring your images contribute to the professional appearance 
of your document: 
 

 Make sure the original image file presents a clean, clear and sharp image. 
 Position images flush left on the page.  

 Extend the image to cover about half (3.5”) or all of the page (6.5”), left to right, 
as described under Inserting and Resizing Images below. 

 Be sure that words and numbers meant to be read are at least 9pt. 

Image Format  
Consistent formatting gives images a uniform, professional appearance. Keep the 
following image format guidelines in mind: 

 Use images with a resolution of 300 dots per inch (DPI) or higher for printing. 
 Keep images close to their original size to reduce degradation. 

 Images that are to be viewed online only may have resolutions as low as 72 DPI.  
 Acceptable image file formats include bitmap (BMP), GIF, JPEG, PNG and TIFF. 

Much depends on the type of image, however, and its intended use, so check with 

the Plans Management team when in doubt. 
 Do not use images copied from websites, as they are too small and distort when 

printed.  
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Inserting and Resizing Images 
Insert images from files, not from clip art or with a link to a Web page. To insert 
and resize an image in your document follow these guidelines: 
 

1. Place your cursor where you want the image to appear. 
2. Choose “Insert” and “Picture” in the ribbon. 

3. Select the image file to insert it on the page.  
4. Right-click the image. 
5. Choose “Size and Position” and check “Lock aspect ratio.” 

6. At “Absolute width,” enter 3.5” for a half page or 6.5” for a full page.  
7. On the “Text Wrapping” tab, choose “Tight.” 

8. On the “Position” tab, set the horizontal “Absolute position” to “0.” 
 

Reposition the image relative to your 
text as needed. We discourage text 

wrapping because it can create a busy, 
hard-to-read page. However, sometimes 
it is important to align a paragraph of 

text horizontally with an image, such as 
a map or photo that requires more than 

a caption. It is best practice to align the 
top of the image and the top of the first 
line of wrap text.  

 

 

Inserting Image Captions 
All the images in your document must have captions. Tables, maps and diagrams, 
however, do not receive captions. Use the following procedure to create captions: 

1. Right-click the image. 
2. Choose “Insert caption.” 

3. In the dialog box that opens, insert two spaces after the figure number, and enter 
your caption and click OK. 

4. In the caption itself, format the text: Verdana, 11 pt., regular, document color. 
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Word gives captions figure numbers, which are useful when referring to particular 
images. For more information on writing informative captions, refer to Accessible 

Images and Captions below. For information on apply the document color, refer to 
Choosing and Changing Color above. 

Maps 
Maps that we create for our plans exhibit the same look and feel as our other 
documents and graphics. Our standards also guide specialists in creating Section 

508 compliant cartographic products that meet the needs of individuals with visual 
impairments. We provide geographic information systems (GIS) users with a tool to 

help them produce and organize map documentation that is consistent with our 
brand and standards.  

Reference Arrow  
The purpose of the reference arrow is to save space. In documents in which it 
appears, it is introduced and explained on the “How to Use This Document” page 

with the following sentence: 

“When you see a reference arrow (↗), look at the bottom of the page for a 

hyperlink to additional information from the State of Texas.” 

The arrow itself is an MS Word symbol. To find it, select the “Insert” tab on the 
ribbon and choose “Symbol.” Choose “More Symbols” and select “Wingdings” from 
the “Font” dropdown menu. Scroll through the symbols until you find the arrow. 

After inserting the arrow, format it in the document color.  

For more information on using the reference arrow, refer to Reference Arrow in the 
Language Style section above. 
 

Figure 1  Mobile medical unit personnel 
must remain focused, sharp and calm to 

be effective. 
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Tables 
Tables follow a specific format so that screen-readers can translate them into voice 
recordings for the sight impaired. For this reason we never merge table cells. In 

other words, tables have a consistent number of columns and a consistent number 
of rows throughout the table. For more information on writing and styling content 

for tables, refer to Tables in the Language Style section above. For more 
information on making tabular information more accessible, refer to the Accessible 
Style section below. 

Our tables are designed to be clear, open and consistently styled. The following 

table presents our typographical standard for tables.  

In case a table breaks across a page, make sure the first row, or header row, of the 

table is selected to “Repeat as header row at the top of each page.” This option 
appears under “Table properties” > “Row. 

 

Element First Row Remaining Rows 

Font Verdana 11 point bold, white 

on document color fill (see 

Borders and Shading below)  

Verdana 10 point regular, black; 

use boldface, document color, in 

column one when it serves as a 
secondary header 

Paragraph 

Settings and Cell 

Margins 

Paragraph line spacing: 

“single,” 3 left, 3 right, 3 pt 

(points) before, 5 pt (points) 
after 

Paragraph line spacing set 

“single,” 3 left, 3 right, 3 pt 

(points) before, 5 pt (points) after 

Text Alignment Text alignment: centered 
horizontally and vertically 

All text left aligned; where first 

column contains labels, first 

column may be right aligned, 
boldface 

Row Height  “at least 0.21”  Content of each cell determines 
height of a given row  

Column Width Variable; avoid two-line 
headers  

Variable; column widths of 
standard tables to be maintained 

Borders and 
Shading 

Document color used as the 
fill for header row 

Document color used for all 

horizontal border lines; line style 

solid and line weight 3/4 pt 
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Visual Style and Formatting Checklist 
Use this checklist to help ensure that your document follows our visual style.  

                   Visual Style Checklist 

 The document is properly formatted in the appropriate template. 

 Text is left aligned, ragged right. 

 Pages do not appear dense or text heavy. 

 Bad breaks have been eliminated. 

 Borders and rules follow design style.  

 Bullets and numbered lists follow design style. 

 The color palette is correctly applied. 

 Verdana is used throughout, except for the reference arrow, which is Calibri. 

 Images are inserted and sized properly. 

 Tables are formatted correctly. 
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Accessible Style 
This section presents guidelines for ensuring our documents are 

accessible to all potential users and comply with Section 508 of the 

Rehabilitation Act of 1973. 

Documentation standards and guidelines help ensure that our communication 

products are accessible to the widest audience possible. 

For this reason, we strive to comply with Section 5089 of the Rehabilitation Act of 

1973, as amended (29 U.S.C. 794d). Texas has enacted similar legislation that 
applies to all state agencies.10 Section 508 stipulates that content be developed to 

meet the following objectives: 

 Content is clear, legible and facilitates comprehension for the widest audience.  

 Content translates easily into alternative formats in order to reach users who would 
otherwise have no access to it. 

Assistive Technology 
Assistive technology translates information for many people who would otherwise 
be denied access to it. For example, screen readers allow navigation within a page, 

announce bulleted lists and tables, spell words, and can be set to read at different 
speeds. However, screen-reader software only pauses for headings, lists and tables 

that contain punctuation. Without these cues, information can sound like a random 
string of words.  

General Guidelines 
Use the following guidelines to help ensure your document is accessible:  

 Punctuation pauses screen readers, so include suitable punctuation.  
 Avoid special symbols because they are not recognized by assistive technologies.  
 Do not abbreviate dates because of differing Americans and Europeans styles.  

 Acronyms and abbreviations are all caps, no periods or spaces. 
 Do not save documents as “Read-only,” since this prevents assistive technology 

from accessing the document.   
 
The table below provides examples of how our style responds to Section 508. 

Standard Non-Standard 

and & 

approximately ~ 

GPA G.P.A. or G P A 

December 1, 2013 12/1/13 

                                       
9 Read more about Section 508 compliance at http:www.section508.gov. 
10 Read about the Texas Accessibility Statute at 

http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2054.htm 

file://HQEMSS001/Public/Sections/Preparedness/PLANS-State%20&%20Federal/Unit%20Internal/Style/Current%20Draft/www.section508.gov
http://www.statutes.legis.state.tx.us/Docs/GV/htm/GV.2054.htm
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Accessible Images and Captions 
Images, such as photos or illustrations, present a challenge because they are not 
accessible to all users. If you use an image, write a descriptive caption to help 

readers understand its meaning and context within the document.  

 

 

 

 

 

 

 

A caption for this photo might read like this: 

Figure 1  Canned food at a shelter 

A more descriptive caption reads as follows: 

Figure 1  Personnel prepare for large quantities of donated food by quickly 
unpacking and setting it up as it arrives.  

Alt Text 
In addition, we add alternative text, also known as alt text, to images so they are 
accessible to the visually impaired. Alternative text is read aloud by screen readers. 
As you write alt text, imagine how you would describe the picture to a reader who 

was not looking at it.  

Alt text for the image above might read as follows: 

Image of a large, open room resembling an empty department store. The 

room is set up with rows of folding tables stacked with great quantities of 
canned goods. Used, empty boxes are loosely stacked against a far wall.  

To insert alt text, follow these steps:  

1. Right-click on the image and choose “Format Picture.” 
2. Click “Alt Text.” 
3. Enter the title, which is the Figure number and caption. 

4. Enter the alt text under “Description” and click “Close.” 
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Accessibility Checklist 
Use this checklist to ensure your documents are accessible and respond to Section 
508 guidelines. 

                      Accessibility Checklist 

 Text layout is clear, simple and consistent. 

 All images and graphics appear crisp and legible. 

 All pages are oriented either vertically or horizontally. 

 All text is formatted according to existing template styles and guidelines.  

 The main text is set flush left, ragged right. 

 There are no textboxes. 

 The table of contents is created using the automated function. 

 Footnotes are inserted using the automated function. 

 Tables follow the format outlined in the Visual Style section above. 

 File names follow the format outlined in the Getting Started section above. 

 
All URLs contain the correct hyperlink and display the fully qualified URL, 

such as http://www.txdps.state.tx.us/dem. 

 

  

http://www.txdps.state.tx.us/dem
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Pre-Review Checklist  
Prior to sending your document out for review, scan this checklist to 

make sure it is in top-notch form. 

Use this checklist to ensure your document is ready for supervisor, stakeholder or 
public review. This list includes a few items that do not appear elsewhere. You may 

wish to add some of your own. 

 Pre-Review Checklist 

 Make sure all comment boxes are deleted. 

 Make sure all changes are accepted. 

 Make sure the track changes feature is turned off. 

 Search for “TK,” “will” and “should.” Edit as needed. 

 Search for “Division” to make sure it modifies “of Emergency Management.” 

 Search for “Department” to make sure it modifies “of Public Safety.”  

 Make sure all standard language sections match the document template. 

 Make sure the planning assumptions are logical and clear. 

 Check all lists, tables and illustrations for proper formatting. 

 Make sure footnotes have been entered properly. 

 Make sure citations are properly entered and formatted. 

 Make sure color is used properly and consistently throughout the document. 

 Make sure all other design elements reflect the design style. 

 Make sure all text is in Verdana according to design style. 

 Make sure images are formatted properly. 

 Review the Accessibility Checklist and consider accessibility issues. 

 Schedule time for another planner to review your document. 

 Incorporate final edits and perform a final grammar check. 

 Scan the entire document for bad page breaks and adjust as needed. 

 Search the document for two spaces after periods and replace with one. 

 Update the entire table of contents, not just the page numbers.  

 Check and update the “Using This Document” page references.  
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Appendix A: Creating Effective Memos  
Memos can persuade others or they can reveal one’s lack of 

knowledge. Use these guidelines to develop professional memos that 

accomplish your objectives. 

Memos are a type of formal communication. Although you may be writing to 

someone you know well, you may not be on hand to clarify or correct your memo’s 
message. Moreover, memos become a matter of record—yours. 

Use memos for the following types of communication: 

 Brief-outs on events or research 
 Proposals 
 Status reports and reports up the chain of command 

 Statements of policy and procedure  
 Introductions and information rollouts 

 Guidance or context surrounding a special occasion 

Leverage the Format 
Begin with our memo template. Use the H1 heading to announce your subject, 

telling the reader what your memo is about. If your memo contains a proposal or 
recommendation, use the pull quote to sell it. Consider these examples:  

Weak: 

 

Stronger: 
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Cover All the Bases 
Regardless of the memo’s content, demonstrate to your reader that you have 
thought about the information carefully. Use the W5H model to address the basic 

information categories: who, what, where, when, why and how. 

Modify these categories to suit your purpose and address the reader’s likely 
concerns. Consider using a table, such as the one below, to organize this 
information.  

Question Response 

Who is involved in this 

initiative?  

 

Whom do we need to bring 

together?  

 

Who is likely to agree?   

Who is likely to oppose it?   

Why?  

 

Add more categories of information if they help bolster your proposal. When making 
your proposal, demonstrate that you have thought it through and are invested in it. 

Category Response 

Pros   

Cons   

Estimated Costs  

 
Anticipating and overcoming objections strengthens your case.  

Check and Cross-Check 
Remember to check your document for typos, missing words, grammatical errors 
and formatting errors. Ask someone else to read it for sense and check it for errors. 

To be taken seriously, your memo must be accurate, clean and error-free.  

Use the following checklist to craft effective memos. 

                          Memos Checklist 

 Use the memo template. 

 Format basic information in a W5H table. 

 Add additional information, such as pros/cons and costs, as needed.  

 When writing proposals, anticipate objections and rebut them.  

 Check and ask others to check your document for errors. 
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Maintenance and Changes 
This section describes the process by which this document is 

maintained and updated.  

Development 
The Plans team developed this document to support the credibility and utility of the 
State of Texas Emergency Management Plan, including the basic plan, its 
emergency support function annexes, support annexes and hazard-specific 

annexes. It is also used to guide all general document development for the Plans 
team. 

While our document types may vary in content, they share fundamental similarities 
in basic construction. These standards are designed to help planners produce 

documents that are correct and communicative in their written expression, are 
uniform and consistent in style, and professional yet user-friendly in their look and 

feel. 

Maintenance 
This is a living document. The Plans team is responsible for changes to it until it is 

superseded. We maintain the document and coordinate updates after receiving 
feedback from TDEM or DPS. 
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For More Information 

For more information about this document, contact Bill Wahlgren, Program 

Specialist, at bill.wahlgren@dps.texas.gov. 

Please direct general questions to Kiran Dhanji, Section Administrator, at 

kiran.dhanji@dps.texas.gov. 

www.tsdps.state.tx.us/dem/preparedness/plansunit.htm 

 

http://www.tsdps.state.tx.us/dem/preparedness/plansunit.htm
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